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Using the Device ManagerUsing the Device Manager

 Accessing the Device Manager

Accessing the Device Manager

 Double

Double

-

-

click the System icon in the Control 

click the System icon in the Control 

Panel and click the Device Manager tab.

Panel and click the Device Manager tab.

 Right

Right

-

-

click My Computer, select Properties 

click My Computer, select Properties 

from the menu and click the Device Manager 

from the menu and click the Device Manager 

tab.

tab.
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Using the Device ManagerUsing the Device Manager

 Viewing 

Viewing 

Devices

Devices

 Viewing by 

Viewing by 

type

type

 Viewing by 

Viewing by 

connection

connection
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Using the Device ManagerUsing the Device Manager

 Computer Properties

Computer Properties

 Accessed by clicking My Computer in the 

Accessed by clicking My Computer in the 

Device Manager and then clicking the 

Device Manager and then clicking the 

Properties button

Properties button

 Can also be accessed by double

Can also be accessed by double

-

-

clicking 

clicking 

My Computer in the Device Manager

My Computer in the Device Manager

 Current resource use can be viewed

Current resource use can be viewed

 IRQs, I/O addresses, DMA channel use and 

IRQs, I/O addresses, DMA channel use and 

memory use can be viewed

memory use can be viewed
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Using the Device ManagerUsing the Device Manager
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Using the Device ManagerUsing the Device Manager

 Changing Device Resources

Changing Device Resources

 Double

Double

-

-

click the device.

click the device.

 Click the Resources tab.

Click the Resources tab.

 Click the specific resource that you want to 

Click the specific resource that you want to 

change.

change.

 Uncheck the 

Uncheck the 

“

“

Use automatic settings

Use automatic settings

”

”

check box.

check box.

 Click the Change Setting button.

Click the Change Setting button.

 Enter the new setting and make sure it 

Enter the new setting and make sure it 

does not conflict with another device.

does not conflict with another device.
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Connectivity IssuesConnectivity Issues

 Four General Categories of 

Four General Categories of 

Network Problems

Network Problems

 The physical environment

The physical environment

 Electrical problems

Electrical problems

 Viruses

Viruses

 Security

Security
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 The Physical Environment

The Physical Environment

 Temperature

Temperature

 Air quality

Air quality

 Magnetism

Magnetism

Connectivity IssuesConnectivity Issues



9

9

Connectivity IssuesConnectivity Issues

 Electrical Problems

Electrical Problems

 Crosstalk

Crosstalk

 Noise

Noise

 Static

Static

 Transients

Transients
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Connectivity IssuesConnectivity Issues

 Viruses

Viruses

 Destructive programs that are normally 

Destructive programs that are normally 

attached to executables or found as macros

attached to executables or found as macros

 Protection is usually obtained by a 

Protection is usually obtained by a 

combination of policies and software

combination of policies and software

 Install anti

Install anti

-

-

virus software

virus software

 Maintain a strict policy governing the use of 

Maintain a strict policy governing the use of 

downloaded files and files on diskettes

downloaded files and files on diskettes
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Connectivity IssuesConnectivity Issues

 Security

Security

 Inability to connect to a network resource 

Inability to connect to a network resource 

may be due to security

may be due to security

 Failure to assign proper permissions to the 

Failure to assign proper permissions to the 

resource

resource

 Failure to enter the proper password or user ID

Failure to enter the proper password or user ID

 Windows NT passwords are case

Windows NT passwords are case

-

-

specific

specific
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Connectivity IssuesConnectivity Issues

 Troubleshooting the NIC

Troubleshooting the NIC

 Card settings

Card settings

 IRQ

IRQ

 I/O

I/O

 Connection port

Connection port

 Use the Device Manager on Windows

Use the Device Manager on Windows

 NT won

NT won

’

’

t allow direct hardware access, so 

t allow direct hardware access, so 

most diagnostic utilities won

most diagnostic utilities won

’

’

t work (boot to 

t work (boot to 

DOS)

DOS)
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Connectivity IssuesConnectivity Issues

 Troubleshooting Your Cable

Troubleshooting Your Cable

 Thinnet

Thinnet

 Diagnostic equipment

Diagnostic equipment

 Moving the terminating resistors to locate a bad 

Moving the terminating resistors to locate a bad 

section of cable

section of cable

 UTP

UTP

 Check the indicator lights on the hub

Check the indicator lights on the hub

 Check to see if the connectors are wired correctly

Check to see if the connectors are wired correctly
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Connectivity IssuesConnectivity Issues

 Troubleshooting Your Hub

Troubleshooting Your Hub

 Diagnostic lights

Diagnostic lights

 Power off and then back on

Power off and then back on

 Use the reset button

Use the reset button

 Bring up one workstation at a time

Bring up one workstation at a time
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Connectivity IssuesConnectivity Issues

 Network Drivers

Network Drivers

 Make sure you are using the proper driver.

Make sure you are using the proper driver.

 Try to use a compatible driver (NE2000).

Try to use a compatible driver (NE2000).

 Protocols

Protocols

 Make sure you are using the proper 

Make sure you are using the proper 

protocols.

protocols.

 Are the protocols configured properly?

Are the protocols configured properly?

 Proper Security to Access the Resource

Proper Security to Access the Resource
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Connectivity IssuesConnectivity Issues

 TCP/IP Basics and Testing Connectivity

TCP/IP Basics and Testing Connectivity

 Using:

Using:

 winipcfg

winipcfg

 nbtstat

nbtstat

 ping

ping

 arp

arp
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Connectivity IssuesConnectivity Issues

 Network Neighborhood

Network Neighborhood

 Browser basics

Browser basics

 Workgroups

Workgroups

 Keeping users who access the same resources in the 

Keeping users who access the same resources in the 

same workgroup or domain results in faster and easier 

same workgroup or domain results in faster and easier 

browsing.

browsing.

 Domains

Domains

 Computers

Computers
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LAN and WAN ConnectivityLAN and WAN Connectivity

 Network Neighborhood

Network Neighborhood

 Why can

Why can

’

’

t you see other computers?

t you see other computers?

 File and/or Print Sharing not loaded on the 

File and/or Print Sharing not loaded on the 

other computers

other computers

 Load File and/or Print Sharing on all computers that 

Load File and/or Print Sharing on all computers that 

you want to be seen in the Network Neighborhood.

you want to be seen in the Network Neighborhood.

 Protocols not loaded or incorrectly configured

Protocols not loaded or incorrectly configured

 Make sure you have properly configured protocols 

Make sure you have properly configured protocols 

and that you are using the same protocols on all the 

and that you are using the same protocols on all the 

computers on your network.

computers on your network.

 Master browse list not updated yet

Master browse list not updated yet

 Try to connect to the shared resource manually 

Try to connect to the shared resource manually 

using 

using 

UNCs

UNCs

(Universal Naming Conventions).

(Universal Naming Conventions).
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Connectivity IssuesConnectivity Issues

 IP Addressing

IP Addressing

 32

32

-

-

bit (4

bit (4

-

-

byte) address with two parts

byte) address with two parts

 Network number

Network number

 Host number

Host number

 Each byte is converted into a decimal 

Each byte is converted into a decimal 

number between 1 and 255 and they are 

number between 1 and 255 and they are 

separated by periods.

separated by periods.

 Example: 100.100.100.100

Example: 100.100.100.100
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Connectivity IssuesConnectivity Issues

 IP Addressing

IP Addressing

 Three common IP address classes

Three common IP address classes

 A

A

1

1

-

-

126

126

~16 million hosts

~16 million hosts

 N.H.H.H

N.H.H.H

 B

B

128

128

-

-

191

191

~64,000 hosts

~64,000 hosts

 N.N.H.H

N.N.H.H

 C

C

192

192

-

-

223

223

254 hosts

254 hosts

 N.N.N.H

N.N.N.H
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Class

A

B

C

Class A

8-bits 8-bits 8-bits8-bits

Network

Host Host Host

Class B

8-bits 8-bits 8-bits8-bits

Network

Network Host Host

Class C

8-bits 8-bits 8-bits8-bits

Network

Network Network Host

1st Octet

1 - 127

128 - 191

192 - 223

Approx. Max Hosts

16,777,214

65,534

254
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IP AddressingIP Addressing

 IP Addressing

IP Addressing

 Basic Rules

Basic Rules

 Each network must have a unique network 

Each network must have a unique network 

address.

address.

 Each workstation on a network must have a 

Each workstation on a network must have a 

unique host address.

unique host address.

 Your IP address must be unique to the rest of the 

Your IP address must be unique to the rest of the 

world if you are on the Internet.

world if you are on the Internet.

 Never use an IP address not assigned to you if 

Never use an IP address not assigned to you if 

you are going to be on the Internet.

you are going to be on the Internet.
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IP AddressingIP Addressing

 IP Addressing

IP Addressing

 Subnets and Subnet Masks

Subnets and Subnet Masks

 Subnets allow you to subdivide a larger network 

Subnets allow you to subdivide a larger network 

into smaller, more manageable units.

into smaller, more manageable units.

 You must provide a subnet mask.

You must provide a subnet mask.
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Subnet MaskingSubnet Masking

 IP Addressing

IP Addressing

 Benefits of subnetting:

Benefits of subnetting:

 Reduced network traffic

Reduced network traffic

 Optimized network performance

Optimized network performance

 Simplified management

Simplified management

 Facilitates spanning large geographical distances

Facilitates spanning large geographical distances
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IP & SubnetIP & Subnet

 IP Addressing

IP Addressing

 Default Subnets

Default Subnets

 Class A default subnet

Class A default subnet

 255.0.0.0

255.0.0.0

 11111111.00000000.00000000.00000000

11111111.00000000.00000000.00000000

 Class B default subnet

Class B default subnet

 255.255.0.0

255.255.0.0

 11111111.11111111.00000000.00000000

11111111.11111111.00000000.00000000

 Class C default subnet

Class C default subnet

 255.255.255.0

255.255.255.0

 11111111.11111111.11111111.00000000

11111111.11111111.11111111.00000000
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IP BinaryIP Binary

 IP Addressing

IP Addressing

 Binary Numbering Convention

Binary Numbering Convention

Position/Value:   128  64  32  16   8   4   2   1

Position/Value:   128  64  32  16   8   4   2   1

Binary Example:     0    0    0    1   0   0   1   0

Binary Example:     0    0    0    1   0   0   1   0

Decimal Equivalent:      

Decimal Equivalent:      

16 + 2 = 18

16 + 2 = 18
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TCP/IP ConfigurationTCP/IP Configuration

 Manually Configuring TCP/IP on Windows 9x

Manually Configuring TCP/IP on Windows 9x

 Double

Double

-

-

click TCP/IP in the Configuration tab of the 

click TCP/IP in the Configuration tab of the 

Network dialog box.

Network dialog box.

 Click the Specify an IP Address radio button.

Click the Specify an IP Address radio button.

 Enter the IP address and subnet mask.

Enter the IP address and subnet mask.

 Click each of the following tabs and enter the 

Click each of the following tabs and enter the 

appropriate information: WINS, Gateway and DNS.

appropriate information: WINS, Gateway and DNS.
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NotesNotes

 Additional Windows Network 

Additional Windows Network 

Configuration Settings

Configuration Settings

 Computer name

Computer name

 Should be 8 characters or less if you will be 

Should be 8 characters or less if you will be 

sharing files or printers with DOS clients

sharing files or printers with DOS clients

 Cannot be the same as a workgroup or domain

Cannot be the same as a workgroup or domain

 Should be something that is easily recognizable 

Should be something that is easily recognizable 

to other users on the network

to other users on the network
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Hidden SharesHidden Shares

 Creating Hidden Shares

Creating Hidden Shares

 Add a dollar sign ($) to the end of the share 

Add a dollar sign ($) to the end of the share 

name.

name.

 The resource will not appear in the Network 

The resource will not appear in the Network 

Neighborhood or any other network browser.

Neighborhood or any other network browser.

 You can also provide share

You can also provide share

-

-

level passwords or 

level passwords or 

user

user

-

-

level security for the resource.

level security for the resource.

 Users will have to manually map to the resource 

Users will have to manually map to the resource 

and they will have to include the $ in the name.

and they will have to include the $ in the name.
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MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools

 MSD.EXE (Microsoft Diagnostics)

MSD.EXE (Microsoft Diagnostics)

 Reports items such as COM ports, parallel 

Reports items such as COM ports, parallel 

ports, IRQs, I/Os and other system 

ports, IRQs, I/Os and other system 

resources

resources

 Should not be run under Windows  or 

Should not be run under Windows  or 

previous versions of Windows

previous versions of Windows

 Only included if your computer was 

Only included if your computer was 

upgraded from a previous version of 

upgraded from a previous version of 

Windows or MS

Windows or MS

-

-

DOS

DOS
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 WINMSD.EXE (Windows NT Diagnostics)

WINMSD.EXE (Windows NT Diagnostics)

 Found on the Administrative Tools group

Found on the Administrative Tools group

 Can be executed from a command prompt

Can be executed from a command prompt

 Displays various information about your system and 

Displays various information about your system and 

the resources that are being used

the resources that are being used

 System resources cannot be changed with this 

System resources cannot be changed with this 

program like they can with Windows  Device 

program like they can with Windows  Device 

Manager

Manager

MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools
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MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools



33

33

MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools
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MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools

 Using Sysedit

Using Sysedit

 Used to edit Autoexec.bat, Config.sys, Win.ini, 

Used to edit Autoexec.bat, Config.sys, Win.ini, 

System.ini, Protocol.ini and other ini files

System.ini, Protocol.ini and other ini files

 Opens all the system files simultaneously

Opens all the system files simultaneously

 Can be accessed by selecting Run from the 

Can be accessed by selecting Run from the 

Start menu and typing sysedit in the Run dialog 

Start menu and typing sysedit in the Run dialog 

box

box

 Files must be saved using the Save command 

Files must be saved using the Save command 

from the File menu after editing them

from the File menu after editing them
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MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools
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MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools

 Sysedit Options

Sysedit Options

 Cut, Copy and Paste

Cut, Copy and Paste

 Search

Search

 Can be case sensitive

Can be case sensitive

 Clear

Clear

 Select all

Select all

 Save

Save

 Print

Print
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MSMS’’s Builts Built--in in 

Troubleshooting ToolsTroubleshooting Tools

 Using Sysedit to Identify Driver Conflicts

Using Sysedit to Identify Driver Conflicts

 First, check the Performance tab of the 

First, check the Performance tab of the 

System program found in the Control Panel.

System program found in the Control Panel.

 Determine whether all systems are using 32

Determine whether all systems are using 32

-

-

bit 

bit 

drivers.

drivers.

 View your Config.sys file

View your Config.sys file

 REM all Device= statements

REM all Device= statements

 Reboot and then recheck to see if all systems are 

Reboot and then recheck to see if all systems are 

functional and using 32

functional and using 32

-

-

bit drivers.

bit drivers.
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The RegistryThe Registry

 Purpose

Purpose

 Replaces many of the functions of .INI files

Replaces many of the functions of .INI files

 Centralizes the settings for the operation of 

Centralizes the settings for the operation of 

the computer

the computer

 Central repository for hardware, software and 

Central repository for hardware, software and 

application settings

application settings

 Less accessible than the old .INI files

Less accessible than the old .INI files
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The RegistryThe Registry

 Where Does the Registry Reside?

Where Does the Registry Reside?

 Three main locations

Three main locations

 SYSTEM.DAT

SYSTEM.DAT

 Most hardware and software configuration settings

Most hardware and software configuration settings

 USER.DAT

USER.DAT

 User information

User information

 Virtual Registry

Virtual Registry

 Files that are created when the system is started

Files that are created when the system is started

 Read

Read

-

-

only access for the user

only access for the user

 Information relating to the performance of the system is 

Information relating to the performance of the system is 

stored here

stored here
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The RegistryThe Registry

 Registry Layout

Registry Layout

 HKEY_CLASSES_ROOT

HKEY_CLASSES_ROOT

 HKEY_CURRENT_USER

HKEY_CURRENT_USER

 HKEY_LOCAL_MACHINE

HKEY_LOCAL_MACHINE

 HKEY_USERS

HKEY_USERS

 HKEY_CURRENT_CONFIG

HKEY_CURRENT_CONFIG

 HKEY_DYN_DATA

HKEY_DYN_DATA
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The RegistryThe Registry

 Inside the Keys

Inside the Keys

 Subkeys

Subkeys

 Value entries

Value entries

 Value name

Value name

 Data type

Data type

 Value

Value
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The RegistryThe Registry

 Searching the Registry

Searching the Registry

 Find command found on the Edit menu

Find command found on the Edit menu

 Click on the key that you want to search 

Click on the key that you want to search 

through.

through.

 Click on the Edit menu and select Find.

Click on the Edit menu and select Find.

 Enter the information you want to find.

Enter the information you want to find.

 Check the possible locations for your 

Check the possible locations for your 

information, such as keys, values names or 

information, such as keys, values names or 

data.

data.

 Click the Find Next button to begin your search.

Click the Find Next button to begin your search.
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The RegistryThe Registry

 Editing the Registry

Editing the Registry

 REGEDIT.EXE for Windows

REGEDIT.EXE for Windows

 Creating a shortcut on your Desktop for 

Creating a shortcut on your Desktop for 

REGEDIT

REGEDIT

 Right

Right

-

-

click your Desktop and select New|Shortcut.

click your Desktop and select New|Shortcut.

 Enter regedit in the Command line text box and 

Enter regedit in the Command line text box and 

click Next.

click Next.

 Enter Registry Editor to identify the shortcut in the 

Enter Registry Editor to identify the shortcut in the 

Select a Title for the Program dialog box, and then 

Select a Title for the Program dialog box, and then 

click the Finish button.

click the Finish button.

 REGEDT32.EXE for Windows NT

REGEDT32.EXE for Windows NT
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The RegistryThe Registry

 Commands in Regedit

Commands in Regedit

 File

File

 Import Registry File

Import Registry File

 Export Registry File

Export Registry File

 Connect Network Registry

Connect Network Registry

 Disconnect Network Registry

Disconnect Network Registry

 Print

Print



45

45

The RegistryThe Registry

 Commands in Regedit

Commands in Regedit

 Edit

Edit

 New

New

 Delete

Delete

 Rename

Rename

 Find

Find

 Find Next

Find Next

You will need to use shortcut keys for Cut, Copy 

You will need to use shortcut keys for Cut, Copy 

and Paste.

and Paste.
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The RegistryThe Registry

 Commands in Regedit

Commands in Regedit

 View

View

 Status Bar

Status Bar

 Split

Split

 Refresh

Refresh
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The RegistryThe Registry

 Running Regedit from DOS

Running Regedit from DOS

 A copy of 

A copy of 

Regedit

Regedit

is placed on the startup disk.

is placed on the startup disk.

 Only a command line interface much like the old 

Only a command line interface much like the old 

Edlin program

Edlin program

 Switches

Switches

 /? 

/? 

-

-

Shows command line syntax

Shows command line syntax

 /L:system 

/L:system 

-

-

Location of SYSTEM.DAT

Location of SYSTEM.DAT

 /R:user 

/R:user 

-

-

Location of USER.DAT

Location of USER.DAT

 /E filename 

/E filename 

-

-

Creates a Registry (.reg) file

Creates a Registry (.reg) file

 /C filename 

/C filename 

-

-

Replaces the entire Registry with the 

Replaces the entire Registry with the 

contents of the specified .reg file

contents of the specified .reg file
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The RegistryThe Registry

 Additional Information

Additional Information

 Back up before you edit.

Back up before you edit.

 Consider other options such as the Control 

Consider other options such as the Control 

Panel first.

Panel first.

 You cannot add a top

You cannot add a top

-

-

level key.

level key.

 Each 

Each 

subkey

subkey

name within a parent key 

name within a parent key 

must be unique

must be unique

 Double

Double

-

-

clicking a value allows you to 

clicking a value allows you to 

modify it.

modify it.
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The RegistryThe Registry

 Remote Registry Editing

Remote Registry Editing

 Requires user

Requires user

-

-

level access

level access

 Microsoft Remote Registry Service must be 

Microsoft Remote Registry Service must be 

running on both machines (Windows )

running on both machines (Windows )

 Windows NT using Regedt32 can edit the 

Windows NT using Regedt32 can edit the 

Windows  Registry

Windows  Registry

 Permission for remote administration must 

Permission for remote administration must 

be granted on the remote machine

be granted on the remote machine
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The RegistryThe Registry

 Backing Up the Registry

Backing Up the Registry

 Microsoft Configuration Backup 

Microsoft Configuration Backup 

(CFGBACK.EXE)

(CFGBACK.EXE)

 Emergency Recovery Utility (ERU.EXE)

Emergency Recovery Utility (ERU.EXE)

 .REG files

.REG files
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The RegistryThe Registry

 Microsoft Configuration Backup 

Microsoft Configuration Backup 

(CFGBACK.EXE)

(CFGBACK.EXE)

 Windows CD 

Windows CD 

-

-

\

\

OTHER

OTHER

\

\

MISC

MISC

\

\

CFGBACK or on 

CFGBACK or on 

the Windows Resource Kit

the Windows Resource Kit

 Allows you to create nine backups, but you can 

Allows you to create nine backups, but you can 

delete backups and continue to create more

delete backups and continue to create more

 Must be run under Windows

Must be run under Windows

 Won

Won

’

’

t back up separate user settings

t back up separate user settings
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The RegistryThe Registry

 Emergency Recovery Utility (ERU.EXE)

Emergency Recovery Utility (ERU.EXE)

 Windows CD 

Windows CD 

-

-

\

\

OTHER

OTHER

\

\

MISC

MISC

\

\

ERU

ERU

 Backs up critical system files to a diskette 

Backs up critical system files to a diskette 

and places ERD.EXE on the diskette

and places ERD.EXE on the diskette

 ERD.EXE runs from DOS

ERD.EXE runs from DOS

 May not get all the system files and gives no 

May not get all the system files and gives no 

warning if all the files weren

warning if all the files weren

’

’

t placed on the 

t placed on the 

diskette

diskette

 May hang if a file is missing

May hang if a file is missing
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The RegistryThe Registry

 Using .REG Files

Using .REG Files

 You can export your entire Registry to a 

You can export your entire Registry to a 

.REG file, which can be imported later if your 

.REG file, which can be imported later if your 

Registry gets corrupted

Registry gets corrupted

 Regedit is used to export and import the file

Regedit is used to export and import the file

 Can be used even if Windows can

Can be used even if Windows can

’

’

t start in 

t start in 

GUI mode

GUI mode
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The RegistryThe Registry

 Other Restore Techniques

Other Restore Techniques

 Let Windows try to fix itself

Let Windows try to fix itself

 You will see a dialog box with an option to 

You will see a dialog box with an option to 

allow Windows  to try to  fix itself

allow Windows  to try to  fix itself

 Restore in DOS mode by replacing the 

Restore in DOS mode by replacing the 

SYSTEM.DAT and USER.DAT files

SYSTEM.DAT and USER.DAT files

 Replace SYSTEM.DAT with SYSTEM.DA0.

Replace SYSTEM.DAT with SYSTEM.DA0.

 Replace USER.DAT with USER.DA0.

Replace USER.DAT with USER.DA0.

 Last resort 

Last resort 

-

-

Replace SYSTEM.DAT with 

Replace SYSTEM.DAT with 

SYSTEM.1st found in the root.

SYSTEM.1st found in the root.
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 Bulletproofing the Registry

Bulletproofing the Registry

 Limit access to the Registry editing tools

Limit access to the Registry editing tools

 Create user profiles

Create user profiles

 Create system policies

Create system policies
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The RegistryThe Registry

 Limiting Access to Registry Editing Tools

Limiting Access to Registry Editing Tools

 Do not allow access to the Windows CD.

Do not allow access to the Windows CD.

 Disallow access to CD

Disallow access to CD

-

-

ROM drives with a 

ROM drives with a 

system policy.

system policy.

 Restrict access to the Registry Editor with a 

Restrict access to the Registry Editor with a 

system policy.

system policy.

 Restrict booting in MS

Restrict booting in MS

-

-

DOS mode by setting 

DOS mode by setting 

computers to boot to the hard drive first and 

computers to boot to the hard drive first and 

by not informing users of the F8 boot option.

by not informing users of the F8 boot option.

 Remove REGEDIT.EXE from the local drive.

Remove REGEDIT.EXE from the local drive.
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Getting Around System Getting Around System 

CrashesCrashes

 Boot Options

Boot Options

 Safe Mode

Safe Mode

 Safe Mode with Networking

Safe Mode with Networking

 Step

Step

-

-

by

by

-

-

Step Confirmation

Step Confirmation

 Logged

Logged

 Command Prompt

Command Prompt

 Safe Mode Command Prompt

Safe Mode Command Prompt
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Getting Around System Getting Around System 

CrashesCrashes

 Safe Mode

Safe Mode

 F5 or F8 and select it from the list

F5 or F8 and select it from the list

 Only device drivers that are necessary to allow 

Only device drivers that are necessary to allow 

GUI mode to run are loaded

GUI mode to run are loaded

 Can be used to change device settings such as 

Can be used to change device settings such as 

IRQ and I/O

IRQ and I/O

 Control Panel will function but no network 

Control Panel will function but no network 

support will be available

support will be available

 Changes should be made one at a time to 

Changes should be made one at a time to 

determine the problem

determine the problem
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Getting Around System Getting Around System 

CrashesCrashes

 Safe Mode with Networking

Safe Mode with Networking

 Loads Windows networking support features

Loads Windows networking support features

 Allows you to access network resources to 

Allows you to access network resources to 

help repair the problem

help repair the problem

 Allows you to back up your local drive to a 

Allows you to back up your local drive to a 

network drive or device in the event a total 

network drive or device in the event a total 

system reload is necessary

system reload is necessary
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Getting Around System Getting Around System 

CrashesCrashes

 Step

Step

-

-

by

by

-

-

Step Confirmation

Step Confirmation

 Allows you to walk through the boot process 

Allows you to walk through the boot process 

and selectively by pass actions to isolate 

and selectively by pass actions to isolate 

possible problems

possible problems

 Should be used if you suspect a problem in 

Should be used if you suspect a problem in 

your boot files such as CONFIG.SYS or 

your boot files such as CONFIG.SYS or 

AUTOEXEC.BAT

AUTOEXEC.BAT
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Getting Around System Getting Around System 

CrashesCrashes

 Logged

Logged

 Creates a file called BOOTLOG.TXT

Creates a file called BOOTLOG.TXT

 The file can be viewed to determine the 

The file can be viewed to determine the 

possible problem

possible problem

 Search for 

Search for 

“

“

LoadFailure

LoadFailure

”

”

 LoadFailure will most likely be at or near the 

LoadFailure will most likely be at or near the 

end of the file

end of the file

 When a device fails to load, first examine the 

When a device fails to load, first examine the 

settings for the device to ensure there are no 

settings for the device to ensure there are no 

conflicts

conflicts
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Getting Around System Getting Around System 

CrashesCrashes

 Command Prompt

Command Prompt

 IO.SYS, MSDOS.SYS and 

IO.SYS, MSDOS.SYS and 

COMMAND.COM are loaded

COMMAND.COM are loaded

 You can access your hard drive as long as it 

You can access your hard drive as long as it 

has not been compressed

has not been compressed

 May be used to replace missing or corrupt 

May be used to replace missing or corrupt 

files

files

 REGEDIT.EXE can be executed in this 

REGEDIT.EXE can be executed in this 

mode

mode
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Getting Around System Getting Around System 

CrashesCrashes

 Safe Mode Command Prompt

Safe Mode Command Prompt

 Nearly identical to Command Prompt mode, 

Nearly identical to Command Prompt mode, 

but it loads Microsoft disk compression 

but it loads Microsoft disk compression 

support

support

 Should be used if you require access to 

Should be used if you require access to 

compressed drives

compressed drives

 Can be used in the same way that 

Can be used in the same way that 

Command Prompt mode is used

Command Prompt mode is used
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Windows Dynamic Link Windows Dynamic Link 

Library Files (.Library Files (.dlldll))

 Dynamic Link Library Files

Dynamic Link Library Files

 Modules containing functions to which a 

Modules containing functions to which a 

program links at runtime

program links at runtime

 Calling application has a line of code that 

Calling application has a line of code that 

references the DLL to retrieve information

references the DLL to retrieve information

 DLL information can be stored in memory 

DLL information can be stored in memory 

and released when not needed

and released when not needed

 Allows smaller memory models to be used 

Allows smaller memory models to be used 

when creating applications

when creating applications
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Windows Dynamic Link Windows Dynamic Link 

Library Files (.Library Files (.dlldll))

 Dynamic Link Library Files

Dynamic Link Library Files

 Several applications may make use of the 

Several applications may make use of the 

same DLL

same DLL

 Older applications may overwrite newer 

Older applications may overwrite newer 

DLLs, which can cause system problems

DLLs, which can cause system problems

 DLLs that are no longer needed due to the 

DLLs that are no longer needed due to the 

fact that their parent program has been 

fact that their parent program has been 

removed are called Orphan DLLs

removed are called Orphan DLLs
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Windows Dynamic Link Windows Dynamic Link 

Library Files (.Library Files (.dlldll))

 Removing Orphaned DLLs

Removing Orphaned DLLs

 Manually removing orphaned DLLs can be 

Manually removing orphaned DLLs can be 

very time

very time

-

-

consuming and is rarely totally 

consuming and is rarely totally 

successful.

successful.

 Any applications that use the Install Shield 

Any applications that use the Install Shield 

can be uninstalled using the Add/Remove 

can be uninstalled using the Add/Remove 

Programs icon in the Control Panel; their 

Programs icon in the Control Panel; their 

DLLs will also be removed during this 

DLLs will also be removed during this 

process.

process.
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Windows Dynamic Link Library Windows Dynamic Link Library 

Files (.Files (.dlldll))

 Removing Orphaned DLLs

Removing Orphaned DLLs

 Using Add/Remove Programs

Using Add/Remove Programs

 In the Control Panel, double

In the Control Panel, double

-

-

click the 

click the 

Add/Remove Programs icon.

Add/Remove Programs icon.

 Select the Install/Uninstall tab.

Select the Install/Uninstall tab.

 Select the application that you would like to 

Select the application that you would like to 

remove, and click the Add/Remove button.

remove, and click the Add/Remove button.

 Windows  will start the Uninstall program and 

Windows  will start the Uninstall program and 

remove the program, all support files and Registry 

remove the program, all support files and Registry 

settings.

settings.

 Be careful about removing shared files.  Make 

Be careful about removing shared files.  Make 

sure you no longer need them.  When in doubt, 

sure you no longer need them.  When in doubt, 

leave them.

leave them.

 Windows  will prompt you to finish the uninstall.  

Windows  will prompt you to finish the uninstall.  

Click the Finish button to complete the process.

Click the Finish button to complete the process.
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Windows Dynamic Link Windows Dynamic Link 

Library Files (.Library Files (.dlldll))

 Third

Third

-

-

party Removal Methods

party Removal Methods

 Clean Sweep

Clean Sweep

 Error Scan

Error Scan

 Norton Utilities

Norton Utilities

 DLLaGator

DLLaGator

 Shaftel Software

Shaftel Software

’

’

s DLL Master

s DLL Master


